
Tutorial: avoiding and correcting
sample-induced spherical aberration
artifacts in 3D fluorescence microscopy
Erin E. Diel1, Jeff W. Lichtman 1,2,3 and Douglas S. Richardson 1,2✉

Spherical aberration (SA) occurs when light rays entering at different points of a spherical lens are not focused to the
same point of the optical axis. SA that occurs inside the lens elements of a fluorescence microscope is well understood and
corrected for. However, SA is also induced when light passes through an interface of refractive index (RI)-mismatched
substances (i.e., a discrepancy between the RI of the immersion medium and the RI of the sample). SA due to RI
mismatches has many deleterious effects on imaging. Perhaps most important for 3D imaging is that the distance the
image plane moves in a sample is not equivalent to the distance traveled by an objective (or stage) during z-stack
acquisition. This non-uniform translation along the z axis gives rise to artifactually elongated images (if the objective is
immersed in a medium with a higher RI than that of the sample) or compressed images (if the objective is immersed in a
medium with a lower RI than that of the sample) and alters the optimal axial sampling rate. In this tutorial, we describe
why this distortion occurs, how it impacts quantitative measurements and axial resolution, and what can be done to avoid
SA and thereby prevent distorted images. In addition, this tutorial aims to better inform researchers of how to correct RI
mismatch–induced axial distortions and provides a practical ImageJ/Fiji-based tool to reduce the prevalence of volumetric
measurement errors and lost axial resolution.

Spherical aberration occurs when light entering the periphery
of a spherical lens is focused to a different point on the optical
axis than paraxial light rays that enter near the lens’s center
(Fig. 1a). Lens-induced SA is well understood and is corrected
for in the optical components of modern microscopes. How-
ever, SA can also be induced by the sample. If converging or
diverging light passes through an interface of differing refrac-
tive indices (RIs), SA will occur. Two scenarios for imaging
through an RI-mismatched interface commonly occur: imaging
with an oil immersion objective into a watery live-cell sample
and imaging into a high-RI mounting medium or tissue-
clearing solution with an air immersion objective. SA created by
these types of RI mismatches has three deleterious effects on
imaging. First, because all the rays of light originating from a
point object do not converge precisely at the image plane,
images are dim and blurred. This can be seen in both wide-field
(Fig. 1b) and confocal (Fig. 1c) light paths, although the con-
focal pinhole may reduce axial blur relative to that of wide-field
microscopy at the cost of further signal loss. Second, owing to
refraction of the more peripheral rays entering the objective—
especially at high numerical aperture (NA) values—the nominal
focus position (where the focal plane would reside in the
absence of refraction) is shifted (Fig. 1b,c). Again, this is seen in
both wide-field (Fig. 1b) and confocal (Fig. 1c) microscopes.
However, in the confocal microscope, the refraction of both

the focusing excitation light and the emitted fluorescence must
be considered. The focal shift is related to the NA of the
objective and the degree of the RI mismatch. Third, and per-
haps most important for 3D imaging, the distance the image
plane moves in a sample is not equivalent to the distance
traveled by an objective (or stage) during z-stack acquisition
(Fig. 1d). This non-uniform translation along the z axis gives
rise to artifactually elongated images (if light travels from a
high-RI immersion medium to a lower-RI sample) or com-
pressed images (if imaging from a low-RI immersion medium
to a higher-RI sample).

Avoiding spherical aberration–based axial distortion
When preparing samples for a microscopy experiment, the
choices of mounting medium and microscope objective are
often made independently. Mounting media are primarily
chosen on the basis of their antifade properties (ability to
prevent photobleaching), whereas objectives are selected on the
basis of their theoretical achievable resolution. The resulting RI
mismatches have little effect on image quality for thin samples
or 2D imaging within a few micrometers of a coverslip. How-
ever, 3D fluorescence microscopy images are rapidly degraded
by SA if the objective’s immersion medium and the sample
mounting medium differ in RI or if an incorrect thickness of
coverslip is used1. Therefore, the choice of immersion medium
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and objective should be made in unison, with the goal being to
match the RI of an objective’s immersion medium as closely as
possible to the RI of the sample’s mounting medium. For
example, water immersion or dipping objectives have long been
preferred for imaging into living samples because the average RI
of a cell (1.360–1.380) is closer to that of water than typical
microscope immersion oil2,3. Further, many water immersion
and dipping objectives have correction collars that can be
adjusted to compensate for coverslip thickness, temperature
and/or RI mismatch3,4. Correction collars therefore extend the
useful RI range of a water immersion objective beyond 1.3333.
Silicone oil immersion objectives (RI = 1.400) offer another
alternative for live-cell imaging. The higher RI of silicone oil
enables these objectives to be designed with higher NAs,
making them particularly suited to super-resolution live-cell
imaging5,6 (see also Table 1). Researchers should take note
because sacrificing theoretical resolution by using a lower-NA
glycerol immersion objective to image samples in glycerol-

based commercial mounting media can produce a higher-
quality image compared with using a higher-NA oil immersion
objective (see ‘Common instances of spherical aberration–based
axial distortion in 3D imaging’).

A perfect RI match between immersion and mounting
medium is not always possible. As an alternative, specialized
hardware that can compensate for RI mismatches can be used.
A dipping cap can be installed to convert an air objective into a
‘pseudo’ dipping lens by attaching a cover with a glass window
to the sample side of the objective7. The glass window is
inserted directly into the mounting medium and maintains a
constant air gap between the front lens and the mounting
medium as the objective moves up and down while imaging the
sample, preventing SA-induced axial distortions. Another
option is to translate the sample inside a chamber filled with
mounting medium while the imaging objective(s) remain(s)
stationary outside the chamber8. A third option is to place a
deformable mirror or spatial light modulator (referred to as
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Fig. 1 | Refractive index mismatches induce spherical aberration and axial distortion. a, Lens-based SA occurs when light rays entering near the edge
of a lens (peripheral rays, orange) are focused before the focal point (f). Light rays entering near the center of the objective (paraxial rays, blue)
intersect the optical axis (gray) at the focal point. b, Ray trace of light traveling from a point source to the image plane in a wide-field fluorescence
microscope. Green shading represents collimated excitation light exiting the objective. Dots (point sources) and lines (ray traces) represent the path
light travels when RIsample > RIimmersion (purple), RIsample = RIimmersion (green), and RIsample < RIimmersion (blue). The point source must be located in a
different focal plane in each situation to ensure its image is focused near the image plane (dashed line); however, when an RI-mismatched interface
exists, SA occurs (see zoomed region, right). c, Ray trace of light traveling from a point source to the pinhole plane in a confocal fluorescence
microscope. As in b, ray tracing diagrams are shown for RI-matched (green) and RIsample > RIimmersion (purple) under confocal illumination and
detection. In a confocal system, both excitation light (shading within green or purple dashed lines) and emitted fluorescence light rays (green or purple
solid lines) undergo refraction if an RI-mismatched interface exists (purple). d, An objective is moved axially (black arrow) in a stepwise manner to
obtain a 3D image. If there is no change in the RI between the objective and the focal point, no refraction will occur (green lines) and the distance the
objective moves (black arrow) is equivalent to the distance moved by the focal plane (green horizontal lines). However, if an RI-mismatched interface
exists between the objective and the object to be imaged, refraction occurs, and the focal point is shifted (purple lines). In this scenario, the movement
of the objective (black arrow) is not equivalent to the movement of the focal plane (purple horizontal lines). Therefore, when imaging a spherical
object (‘actual object’, purple) that is embedded in a medium with an RI value higher than that of the immersion medium of the objective, a 3D
rendering of the object will be compressed in the axial dimension (‘apparent object’, green) because the acquisition software has assigned the distance
of the objective’s travel—not the focal plane’s travel—to the object’s z axis.
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adaptive optics) to correct the many types of aberrations that
can occur across a field of view9. Finally, radially symmetric
phase masks have been used to equilibrate the SA across
all depths of a sample, enabling simplified image restoration
by deconvolution after image aquisition10. Although these
options are useful, they require specialized equipment that
may not be an option for every researcher. Therefore, meth-
odologies to correct for axial distortion via post-processing are
still required.

Common instances of spherical aberration–based axial
distortion in 3D imaging
Throughout this tutorial, we will focus on one historic and two
modern RI mismatches in 3D fluorescence microscopy. First,
when confocal microscopy was pioneered in the early 1990s,
live biological samples (RI = up to 1.380) were primarily
imaged with oil immersion objectives (RI = 1.518) because
these had the highest NAs and were thought to achieve the
highest possible theoretical resolution. As discussed above, the
use of oil immersion objectives for live-cell imaging produces
an artificial stretching of the data in the axial dimension. Sec-
ond, modern-day fixed fluorescent samples are primarily
mounted in glycerol-based antifade mounting media (RI =
1.400–1.470) and imaged with air (RI = 1.000) or oil (RI =
1.518) immersion objectives. Imaging of this nature will artifi-
cially compress (air objective) or stretch (oil objective) the 3D
images. Third, imaging of tissue that is millimeters in thickness
is now commonplace via advanced confocal and light-sheet
microscopy techniques in combination with tissue-clearing
approaches (RI = 1.380–1.560) (ref. 11). In all three of these
situations, the RIs of the most common objective immersion
media (air, glycerol, oil) rarely match the RI of the sample to be
imaged (Table 1). Although oil or glycerol immersion objectives
provide a reasonable RI match to many samples, the primary
role of these immersion media is to increase the NA of an
objective and thus its theoretical resolution. Unfortunately,
increasing the NA of an objective results in a decrease in
working distance and field of view (unless the diameter of the
front lens is also increased). Therefore, most fluid immersion
objectives are limited to a working distance of a few hundred
micrometers and are incompatible with 3D imaging of thick
samples. For these reasons, air objectives are used for imaging
thick sectioned and/or cleared tissue because of their long
working distances and large fields of view. Air objectives will

always induce SA-based axial distortion when used for 3D
imaging because the RI of any sample is >1.000 (the RI of air).
The appearance of axial distortion from the use of air objectives
is therefore quite common in published works. RI mismatches
in cleared-tissue imaging are especially hard to avoid (Table 1)
and can be found in several published works, including early
pioneering studies12,13. The artificial compression of 3D images
that occurs when imaging into high-RI cleared samples has a
severe impact on quantitative measurement of volume and can
also affect axial resolution.

Calculating axial distortion correction factors (high to
low RI mismatch)
If an RI mismatch cannot be avoided, 3D images must be
corrected for axial distortion. SA-based axial distortion of
images was first noted during the early development of confocal
microscopes. At this time, confocal microscopes primarily used
high-NA oil immersion objectives (RI = 1.518) to image live-
cell cultures (RI = 1.360–1.380) or fixed-cell cultures (RI =
1.400–1.470) with lower RIs. This RI mismatch resulted in an
artificial stretch in the axial dimension during imaging. Using a
simple ray optics approach, Carlsson14 first proposed that this
focal shift could be predicted by calculating a correction
factor by obtaining the ratio of the RI of a sample’s mounting
medium to the RI of the imaging objective’s immersion
medium (nsample/nimmersion). Although Carlsson’s calculation
provides a good approximation for low-NA objectives, it does
not account for the increased axial distortion that is observed
with high-NA objectives. Therefore, at high NA, the Carlsson
formula underestimates the focal shift. Soon after, Visser et al.15

developed a formula to calculate axial distortion that considered
the NA of the objective (Eq. 1).

Δf ¼
tan sin�1 NA

n1

� �

tan sin�1 NA
n2

� �Δs ð1Þ

Here, Δf represents the movement of the focal plane within
the sample and Δs represents the movement of the stage or
objective. Unfortunately, Sheppard et al.16 and Hell et al.17 later
showed that Eq. 1 overestimates the axial distortion at high NA
values because it considers only the most peripheral rays
emitted from an objective lens and ignores the relatively greater
contribution from paraxial rays. In 1993, Hell et al.17 provided a
wave optics solution that is now widely accepted as the most

Table 1 | Summary of common refractive indices in microscopy

RIs of common objective immersion media RIs of common biological samples

Immersion medium RI Sample RI

Air 1.000 Live tissue 1.360–1.380

Water 1.333 Fixed tissue in glycerol-based mounting medium 1.400–1.470

Silicone oil 1.405 Fixed tissue in high-RI mounting medium 1.520

85% Glycerol 1.456 Aqueous-based cleared tissue 1.380–1.460

Oil 1.518 Solvent-based cleared tissue 1.500–1.560
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accurate estimation of axial distortion. Using this method, they
were able to predict the decrease in resolution, the decrease in
signal intensity and the focal distortion at various imaging
depths with high precision. However, wave optics requires
complex calculations, and this complexity has probably con-
tributed to the underutilization of this method within the
microscopy community. Currently, if microscopists desire to
correct an axially distorted image after acquisition, they have
the choice of two simple, but inaccurate, equations or one
highly complex mathematical formula. Here, we describe two
simple modifications to Eq. 1 that can be used to improve its
accuracy at high NA and/or large RI mismatches.

Rather than calculating the focal shift of only the most
peripheral rays (Visser et al.15, Eq. 1), we recommend calcu-
lating the mean or median depth at which 100 rays equally
spaced along the radius of an objective’s front lens intersect the
optical axis in the sample. We have found that this simple ray
optics approach approximates the complex, and difficult to
implement, wave optics methods of Hell et al17 quite well.
Therefore, we recommend the use of Eq. 2 (mean) or 3
(median) (see derivation in Supplemental Note 1) for correcting
axial distortion when imaging through RI mismatches.

d0
d
¼ 1

100
�
X100

k¼1

tan sin�1 kNA
100n1

� �

tan sin�1 kNA
100n2

� � ð2Þ

d0
d
¼

tan sin�1 0:5NA
n1

� �

tan sin�1 0:5NA
n2

� � ð3Þ

In Eqs. 2 and 3, dʹ/d is a correction factor that relates the
actual focal position (dʹ) to the expected focal position (d). k is
an integer used to increment through equally spaced rays along
the radius of the optical axis. Figure 2 shows that Eqs. 2 and 3
perform better than the ray optics approaches of Carlsson and
Visser et al. as compared with the wave optics calculations from
Hell et al. In addition, Eqs. 2 and 3 are not biased by high NA
values (Fig. 2a) or large differences in RI values (Fig. 2b), as is
Eq. 1. Therefore, Eqs. 2 and 3 are simple formulas for esti-
mating the focal shift when imaging from a high (oil immer-
sion) to low (water) RI. We discuss the differences between the
mean and median approaches in the ‘Mean versus median
correction factor’ section below.

3D imaging from a high-RI oil immersion medium to a
lower-RI live-cell sample is rare today because most researchers
know to select water or silicone oil immersion objectives for
these types of experiments. However, imaging from a high RI to
a low RI in fixed samples is still common. Most commercially
available mounting media are glycerol based and have an RI
close to 1.450. Clearly, this is poorly matched to the RI of
immersion oil (1.518). According to Eqs. 2 and 3, axial cor-
rection factors of 0.92 or 0.94, respectively, should be applied to
images acquired under these conditions (RI immersion = 1.518;
RI sample = 1.45; NA = 1.4). However, in practice the axial
distortion of these samples is often minimal because the short
working distances of high-NA oil immersion objectives

(100–200 µm) limits the maximal axial distortion (stretch) to
tens of micrometers.

Calculating axial distortion correction factors (from low
to high RI)
Currently, a greater concern is the opposite imaging situation:
imaging from a low-RI immersion medium into a high-RI
sample. This occurs when air immersion objectives are chosen
to facilitate imaging large fields of view (due to lower magni-
fication) or thicker samples (due to longer working distances).
It can also occur when immersion objectives are used to image
into samples cleared with high-RI tissue-clearing solutions.
Therefore, it is important to compare the performance of the
various axial distortion correction strategies when imaging
from a low-RI immersion medium (such as air) into a high-RI
mounting medium or tissue-clearing solution. To our knowl-
edge, a wave optics approach has not been applied to this low
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Fig. 2 | Comparison of methods for determining refractive index–
mismatch correction factors (high to low refractive index). Correction
factors were calculated and plotted using equations and data from
Carlsson14, Visser et al.15 (Eq. 1), Hell et al.17 and Eqs. 2 and 3 of the
current paper. a, The axial correction factor was calculated across NA
values of 0.3–1.3 for an oil immersion objective (RI = 1.518) imaging
into a solution of RI = 1.33. All methods show close agreement at NA <
0.5. b, The axial correction factor was calculated for an NA = 1.3 oil
immersion objective imaging into solutions ranging in RI from 1.3 to 1.6.
Equations 2 and 3 of the current paper (solid blue and orange lines)
show the best agreement with wave optics calculations by Hell et al.
(magenta dots).
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RI to high RI imaging scenario. However, ray optics can be
easily extended to this context. Figure 3 displays correction
factors for imaging into high-RI samples with air immersion
objectives calculated with the same ray optics approaches used
in Fig. 2. Again, the Carlson and Visser equations appear to
underestimate or overestimate, respectively, the correction
factor at high NA values.

Experimental demonstration of correcting axial
distortions
Validation using fluorescent beads
To confirm the validity of Eqs. 2 and 3 when imaging from low
to high RI, a simple experiment can be performed. Fluorescent
beads are fixed to a microscope slide and overlaid with solu-
tions of differing RI (see Supplementary Methods). A coverslip
is then placed above these solutions on a spacer (Fig. 4a). If a
3D field of view is imaged at the interface of these solutions and
the neighboring empty space, the focal shift due to SA can be
calculated. Figure 4b displays such an experiment, in which
2-µm fluorescent beads were placed 200 µm below a coverslip.
Droplets of immersion media with RI = 1.333 and RI = 1.518

were placed over the beads. When images were taken at the
interface of these solutions with a 0.45-NA air immersion
objective, the beads in high-RI medium (1.333 or 1.518)
appeared elevated above the glass slide relative to those residing
in air (Fig. 4b–d). In this example (RI immersion = 1.000; RI
sample = 1.000, 1.333 or 1.518; and NA = 0.45), Eqs. 2 and 3
calculate nearly identical correction factors for the following
conditions: 1.00 (beads in air), 1.35 (beads in RI = 1.333), and
1.54 (Eq. 3) or 1.55 (Eq. 2) (beads in RI = 1.518). If Eqs. 2 and 3
are accurate, multiplying the z spacing of the images by the
correction factor should restore the beads to their correct axial
positions. Figure 4c (right panels) and 4d show exactly this
(using Eq. 2). Therefore, Eqs. 2 and 3 can be used to correct 3D
volumetric data that is distorted by imaging from a low-RI
immersion medium into a high-RI sample.

Correcting axial distortion in 3D volumes
Figure 1d depicts how SA causes the image plane to move
through a sample at a different rate than the objective (or stage)
travels during 3D image acquisition. This mismatched travel
speed results in an SA-induced z-axis elongation or compres-
sion that must be corrected before performing quantitative
volumetric analysis. Figure 5a illustrates one of the common
experimental conditions discussed above: imaging a sample in a
glycerol-based commercial mounting medium (RI = 1.460). If
a glycerol objective is chosen, the immersion medium is well
matched to the RI of the mounting medium and no axial
distortion correction is required. Here, a measurement along
the z axis represents the true thickness of the tissue section
(Fig. 5a). When the exact same region is imaged with an air
immersion objective of equivalent NA, the resulting image is
axially compressed to approximately 60% of its actual thickness
(Fig. 5a). To correct for this compression, a correction factor
should be calculated using Eq. 2 or 3 and the values RI
immersion = 1.000, RI sample = 1.460, and NA = 0.8. Next,
the z step of the acquired image is multiplied by the correc-
tion factor (1.59, via Eq. 2) to stretch the image to its actual
thickness (Fig. 5a, compare air immersion original (Org) with
z-corrected (Zcor)). Similarly, when imaging a cleared organoid
(clearing solution RI = 1.560, see Supplementary Methods)
with a 0.45-NA air immersion objective, the raw data are
artificially compressed in the axial dimension. Volumetric
analysis of the original and corrected images suggests the
volume of the organoid is underestimated by more than 1.5× if
uncorrected (Fig. 5b). A correction factor of 1.59 (calculated
using Eq. 2) adjusts the axial dimension of the image, and a
more accurate estimation of the spheroid’s volume is obtained.
Therefore, before performing volumetric measurements on 3D
images acquired through an RI-mismatched interface, it is
essential that the axial distortion be first corrected following the
methods outlined below.

Experimental demonstration of determining axial
sampling rates
Effect of spherical aberration on axial sampling
SA-induced distortion can also affect the achievable axial
resolution of a microscope. Because the movement of the focal
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a, The axial correction factor was calculated across NA values of 0.3–0.9
for an air immersion objective (RI = 1.000) imaging into a solution of
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plane within a sample is accelerated or decelerated relative to
the physical movement of the objective, the optimal z step (axial
sampling rate) must be adjusted accordingly. It is well under-
stood that to maximize the resolution of a microscope in any
dimension, the sampling rate (number of pixels) must be at
least twice the theoretical resolution limit of the imaging system
(referred to as Nyquist sampling). Several equations (for an
example, see Supplementary Note 2) can be used to determine
the correct z step. Commercial microscope software uses these
equations to recommend an ‘optimal’ axial sampling rate.
Unfortunately, these equations will recommend too small
(if imaging from high to low RI) or too large (if imaging from
low to high RI) of a z step when imaging through an RI-
mismatched interface. Therefore, when imaging into a lower-RI
sample (relative to the immersion medium of the objective), the
z planes will be too close together, and excessive photobleaching
or phototoxicity may be induced in the sample. Conversely,
when imaging into a higher RI sample, the z step will be too

large, and the achievable resolution of the microscope will be
reduced. Figure 5c demonstrates that imaging at the suggested z
step fails to resolve all labeled axons in an axial (xz) maximum
intensity projection of a thick tissue volume. All images were
corrected after imaging for axial distortion, demonstrating that
the sampling rate must be determined before, not after, imaging
is performed.

Correct axial sampling improves segmentation
The initial step of most image analysis routines is to segment
objects of interest. Failure to adjust the axial sampling rate
(z step) according to any RI-mismatches that exist between the
sample and the objective’s immersion medium will impact a
researcher’s ability to properly segment individual objects.
Figure 6a displays an automated segmentation of the image in
Fig. 5c. More objects are segmented (12 versus 7) when the
correct axial sampling rate is calculated before imaging and
the z spacing is corrected after acquisition. The increase in the
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RI values. Fluorescent beads (green circles) were adhered to a microscope slide between double-sided tape spacers (Supplementary Methods). Drops
of RI = 1.333 (blue) and RI = 1.518 (gray) liquids were placed over the beads. A no. 1.5 coverslip was placed on the liquid drops and spacers. Red boxes
indicate areas of air–liquid interfaces, where multiple beads residing in both RIs could be imaged in a single field of view. b, 3D rendering of volumes
captured at the air–liquid interface, as indicated in a, using 200-µm spacers. The left panel images through a liquid with RI = 1.518, and the right panel
images through RI = 1.333. Beads (2 µm; green) were visualized by fluorescence microscopy; the coverslip and glass slide surfaces were visualized by
reflected light imaging (magenta), and the edge of the droplet was detected via transmitted light (intensity is inverted and pseudo-colored gray; see
Supplementary Methods). Beads appear elevated when overlaid with solution. White boxes are 40 µm2. c, The experiment in b was repeated
with a 100-µm spacer. Orthogonal (xz) color-coded depth projections of individual fluorescent beads are presented. The color of the bead indicates its
distance from the glass slide according to the color scale. Reflections from the coverslip and microscope slide are shown in magenta.
z-corrected images of the 1.333- and 1.518-RI embedded beads are also shown in the right-hand panels. Scale bar, 10 µm. d, Distance from the glass
slide (apparent focal shift) was calculated and plotted for five beads outside the liquid drops (RI = 1.000, pink dots), five beads in the RI = 1.333
medium (green dots), and five beads in the RI = 1.518 medium (cyan dots). The distances between the beads in RI = 1.333 and RI = 1.518 and
the slide were remeasured after applying a z correction as in c (green and cyan triangles, respectively). Red bars indicate the expected bead positions
predicted by Eq. 2.
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number of segmented objects results for two reasons. First, in
an undersampled dataset, thin objects that lie parallel to the
lateral plane may appear on only a single (or very few) slice(s).
Therefore, the object’s 3D volume is small and falls below the
volume threshold value that is set to exclude small, artifactual
objects. If an object’s volume is below the set threshold, it is
deemed too small to be relevant and is excluded. These objects
cannot be recovered by lowering the threshold because the
image becomes overwhelmed with small punctate structures
that often represent debris or staining artifacts. In Fig. 6a, the
threshold was set to 10,000 pixels. Four thin objects that lie in
the lateral plane can be segmented only in the properly sampled

dataset (Fig. 6a, right panel, white arrowheads). Second, objects
lying directly above one another can falsely appear connected if
the axial sampling rate is insufficient to resolve both structures.
Figure 6b displays two axons that could not be segmented in
the undersampled dataset but are clearly two separate objects
when the sample is reimaged at the correct axial sampling
rate. Therefore, it is critical to calculate an adjusted axial
sampling rate (z step) before imaging to ensure optimal axial
resolution as described in the methods outlined below. It is
essential to understand that axial resolution cannot be increased
or recovered through post-processing if the original image is
under sampled.
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Fig. 5 | Refractive index mismatches induce spherical aberration and axial distortion. a, A 50-µm-thick region of mouse brain tissue expressing the
tdTomato fluorescent protein in a subset of neurons was imaged with a 20× 0.8-NA air or a 25× 0.8-NA glycerol immersion objective (Supplementary
Methods). Gamma-adjusted (0.5) maximum intensity projections are displayed for the lateral (xy) and axial (zy) planes. The zy plane is shown before
(Org) and after (Zcor) z-axis compression correction for the air objective. The relative thickness (z dimension), normalized to the glycerol immersion
projection (Glyc Imm Org), is displayed for the air immersion objective’s original (Air Imm Org) and z-corrected (Air Imm Zcor) projections. Scale bar,
50 µm. b, Lateral (xy) and axial (xz) slices through an organoid labeled with the SiR-DNA nuclear dye are presented. Organoids were cleared
(Supplementary Methods) and imaged in dibenzyl ether (RI = 1.560) with a 10× 0.45-NA objective. Volumetric measurements were calculated for
3D-rendered uncorrected and z-corrected datasets. Scale bar, 100 µm. c, Lateral (xy) and axial (xz) maximum intensity projections were calculated for
confocal image stacks acquired through the same mouse brain section as in a. The volume was imaged twice: (1) using the manufacturer’s
recommended z step (undersampled) and (2) at an adjusted z step that accounts for SA-induced focal shift (see Supplementary Note 2). To quantitate
the number of neuronal processes resolved under different sampling conditions, pixel intensity profiles were determined along the indicated
dotted lines and plotted; Roman numerals in the images correspond to those in the plots. Red dots represent individually resolved axons.
Scale bar, 10 µm.
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An ImageJ/Fiji-based macro for axial distortion
correction and optimal z-step determination
Equations 2 and 3 allow less complex calculations than wave
optics methods but are still not simple enough for rapid manual
calculation. Therefore, we have developed an ImageJ/Fiji-
based18,19 macro that allows researchers to (i) ensure the
highest achievable axial resolution and prevent excess photo-
toxicity by calculating the optimal z step for their experiment
before imaging and (ii) correct any axial distortions (com-
pression or stretch) after imaging (see Box 1 for a step-by-step
procedure for installation and application of the macro). The
macro is run before imaging to calculate an optimal axial

sampling rate (use the ‘Provide recomended Z-step only’ option
as indicated in Box 1, step 8A(iv)). After imaging is complete,
the macro is rerun to adjust the z spacing of the acquired
dataset and correct SA-induced axial distortion using Eqs. 2
and/or 3 (Box 1, step 8A(viii–xiv)). If sufficient metadata exist,
the macro will warn users if their acquisition z step was too
large during imaging and thus limited the achievable axial
resolution.

Mean versus median correction factor
Equations 2 and 3 present two ray optics–based approaches for
calculating a correction factor for SA-induced axial distortion.
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Fig. 6 | Correcting axial sampling improves segmentation. a, An N-class thresholding based on k-means classification (hierarchical k-means, Icy
(http://icy.bioimageanalysis.org/download/)) automated segmentation routine was applied to the data in Fig. 5c. Each color represents an
individually segmented object. Maximum intensity projections of the volume are presented along the xy, xz, and zy planes. White arrowheads indicate
thin objects that are excluded in the undersampled dataset because of their z compression. Scale bar, 10 µm. b, 3D renderings of the white boxed
region in a (right-hand xy image). Volume renderings along the xy, zx, and yz axes are shown. White dashed boxes in the yz images highlight an area
that is poorly segmented in the undersampled data. White grids in background measure 10 × 10 µm.
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Box 1 | Installation and application of the focal shift correction macro ● Timing Installation: 15 min; calculate sampling rate:
2 min; correcting axial distortion: minutes to hours depending on number and size of files

This box provides a step-by-step procedure for the installation (Steps 1–7) and use (Step 8) of the macro. The source code can be copied directly
from the Supplementary Software. Correct use of the macro before image acquisition (Step 8A(i–v)) will ensure that the full resolving power of the
microscope is utilized. Following acquisition, Step 8A(vii–xiv) describes how to correct RI mismatch–induced axial distortion before 3D
visualization and analysis. Alternatively, the post-acquisition processing steps can be avoided if a microscope’s control software allows the input of
RI-mismatch correction factors (Step 8B).

Macro installation procedure
1 Install or update to the current version of ImageJ19 (https://imagej.nih.gov/ij/download.html) or Fiji18 (https://fiji.sc/). If using ImageJ, you
must also install a current version of the Bioformats plugin (https://docs.openmicroscopy.org/bio-formats/5.8.2/users/imagej/installing.html).

2 Open ImageJ/Fiji.
3 Open a new macro editor window (‘Plugins’ > ‘New’ > ‘Macro’).
4 Copy the source code from the Supplementary Software and paste it into the macro editor window.
5 On the ‘Language’ dropdown menu, select ‘IJ1 Macro’.
6 Click ‘File’ > ‘Save as’ and save the macro to the ImageJ ‘plugins’ folder. The file name must contain an underscore (‘_’).
7 Restart ImageJ/Fiji and locate the macro at the bottom of the ‘Plugins’ dropdown menu.

Procedure for using the macro
8 To use the macro to calculate an optimal axial sampling rate (before image acquisition) and correct axially distorted images after acquisition,

follow option A. To use the macro in conjunction with microscope control software that allows user-input RI mismatch correction factors, follow
option B.
(A) Using the macro to calculate an optimal axial sampling rate and correct axially distorted images

(i) Ensure that the macro is saved in the ImageJ/Fiji ‘plugins’ folder (see step 6 above).
(ii) Run the macro by selecting it from the ‘Plugins’ menu.
(iii) Fill in the requested information as shown in the example screenshot below:

(iv) Check ‘Provide recommended Z-step ONLY’ to output the recommended z step without processing any data.
(v) Click ‘OK’. The recommended z step will be printed in the ImageJ/Fiji ‘Log’ window.
(vi) Proceed to the microscope to image the sample.
(vii) Enter the macro’s recommended z step into the corresponding location of the microscope control software.
(viii) Once imaging is completed, place all Bioformats-compatible image files (such as ome.tif, .czi, .lif, .nd2, .oif files) to be processed into

a single folder (directories, subdirectories and files names must not contain spaces).
(ix) Create an empty ‘output’ folder.
(x) Run the macro by selecting it from the ‘Plugins’ menu in ImageJ/Fiji.
(xi) Fill in the requested information as shown in the example screenshot above (step 8A(iii)).
(xii) Check ‘Correct images using mean axial shift’ to use Eq. 2 (mean) and/or ‘Correct images using median axial shift’ to use Eq. 3

(median) when calculating the z-correction factor.
(xiii) Check ‘Batch process multiple files’ if more than one image is to be processed (all images must have been acquired using the same

conditions: NA, immersion RI, mounting RI) and click ‘OK’.
(xiv) Locate the input and output folders when requested. The corrected images will be saved to the output folder as .tif stacks and can be

opened directly.
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Equation 2 calculates the mean intersection point of 100 rays
with the optical axis, whereas Eq. 3 calculates the median
intersection point. For objectives with low NA (< ~0.5) imaging
through minimal RI mismatches (< ~0.15), the two methods
calculate nearly identical correction factors (Fig. 2). At higher
NA (>0.5) and larger RI mismatches (>0.15), Eqs. 2 and 3 differ
slightly but agree well with the wave optics calculations of Hell
et al. (Fig. 2). Equation 2 calculates a higher degree of correction
at high NA and large RI differences, whereas Eq. 3 (median)
determines less correction is required relative to wave optics. Of
the ray optics approaches investigated here, Eqs. 2 and 3 show
the closest agreement to wave optics calculations across various
NAs and RIs when imaging from a high-RI medium into a

lower-RI sample (Fig. 2). The differences in correction factors
calculated by Eqs. 2 and 3 and wave optics formulas are
minimal. For example, the calculated focal shift for a 1.3-NA oil
immersion objective imaging into a RI = 1.333 water solution
are all within 20 nm of one another, well below the resolving
power of the microscope. Although we do not have wave optics
data for the inverse situation (imaging from a low-RI immer-
sion medium into a higher-RI sample), Eqs. 2 and 3 are still in
good agreement with one another (Fig. 3). Both equations show
a response to increasing NA (unlike Carlsson), but neither is as
heavily influenced by NA as Visser et al. (Fig. 3a). Therefore,
Eqs. 1 and 2 provide accurate correction factors for imaging
through high to low or low to high RI mismatches.

(B) Using the macro together with microscope acquisition software with an RI mismatch correction function
(i) Ensure that the macro is saved in the ImageJ/Fiji ‘plugins’ folder (see step 6 above).
(ii) Run the macro by selecting it from the ‘Plugins’ menu.
(iii) Fill in the requested information as shown in the example screenshot above.
(iv) Check ‘Provide recommended Z-step ONLY’.
(v) Click ‘OK’. Along with the recommended z step, an axial distortion correction factor will be printed in the ImageJ/Fiji ‘Log’ window.
(vi) Proceed to the microscope to image the sample.
(vii) Enter the macro’s recommended z step in the corresponding location of the microscope control software.
(viii) Enter the macro’s recommended axial correction factor in the corresponding location of the microscope control software (screenshot

below displays location for Carl Zeiss’ ZEN Black or Blue software).

(ix) No further processing is required after image acquisition.

Box 1 | (continued)
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Limitations of the macro
The macro is not able to correct the lateral or axial blur that is
introduced by SA or improve lateral or axial resolution after
acquisition. SA-induced blur increases with objective NA and
imaging depth. Increases in computing power now allow
deconvolution to be applied to large 3D datasets, and decon-
volution has been used to correct for the blur and axial shift
induced by SA. SA correction via deconvolution requires a
model of the blur introduced by SA and other factors such as
diffraction within the entire optical path (microscope and
sample), called the point spread function (PSF). Theoretical
PSFs can be calculated, but they do not always consider SA and
are commonly isometric in the axial dimension. Therefore, care
must be taken when using theoretical PSFs to ensure that a
model of SA blur is included and that axial shifts are corrected.
Both open-source and commercial software are available for
performing this level of deconvolution20,21. In addition,
experimentally determined PSFs can be measured and used for
deconvolution. Experimental PSFs can be obtained by imaging
beads submerged in the sample mounting medium at various
depths under a coverslip (Fig. 4a). For relatively thin samples,
beads placed at a depth of half the sample’s thickness may
suffice. For thick samples, PSFs measured at multiple distances
may be necessary22–24.

Reporting Summary
Further information on research design is available in the
Nature Research Reporting Summary linked to this article.

Data availability
All original (raw) data are available from the authors upon
reasonable request.

Code availability
All necessary code and instructions for running the axial cor-
rection macro are provided in the Supplementary Software and
Box 1.
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